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EDITORIAL
As I touched on in my editorial at the end of Volume 9, we live in changing times, with multiple media routes
for delivering things like this journal and the other services that GCG members should expect as paid-up
members and part of our community. The results of a survey of members and others concerned with
geological curation are presented and discussed in a paper here by the entire Committee of GCG, led by the
Chairman Giles Miller. It makes for interesting reading and has given the committee many pointers as to how
to take GCG ahead in the next few years.
Some of the questions that arise from this survey are things that can be easily addressed. The survey results,
along with trends in technology and the way people access information, indicate the Coprolite newsletter is
no longer as effective as we would wish. Along with the significant cost of printing and posting it, a decision
has been made to cease production in its present format. It will continue as an electronic publication (with
paper copies still available on request), but issued more frequently and therefore more useful in keeping
members alerted to forthcoming meetings in good time.
Many of the other issues raised by members and others in terms of training and information needs will be
addressed through a new set of Guidelines for the Curation of Geological Materials. The original version was
published in 1985 and was a major milestone for GCG. However, it has been planned to produce a second
edition for some years now, but various delays have occurred. In 2015 you will see the new Guidelines appear
in a new format. It will be provided as downloadable pdfs on separate topics within a flexible structure that
allows it to grow and be added to with revised versions and new topics as it develops. The emphasis will be
on really practical assistance, rather than a theoretical best practice approach.
The future of The Geological Curator journal was also part of the survey, but the results were less clear in
guiding the Committee as to what people wanted and where financial savings might be made. Clearly many
people would be happy to accept electronic delivery of the journal in future, but the financial savings to GCG
are not in a linear relationship to the numbers not taking print copy, and many people still want print. In
addition the survey was mostly responded to by individuals, and our subscriber base includes many
institutions. There are also many technical issues to be addressed relating to effective delivery to members of
electronic copy, and how to manage that and balance the pressures for completely open access versus the
benefits for members of paying their subscription.
Consequently we have decided that a more detailed survey relating solely to the future of The Geological
Curator would be helpful in making difficult decisions. We especially need to canvas the institutional
members for their views. I would urge every reader to complete the enclosed paper questionnaire and return
it. It can be posted or a scan emailed to geologicalcuratorsgroup@gmail.com.
This volume also includes the text of a Memorandum of Understanding signed at the 2014 Annual Meeting
of the Society for the Preservation of Natural History Collections (SPNHC). This year it was held in Cardiff
in partnership with the Natural Sciences Collections Association (NatSCA) and the GCG. At the meeting we
agreed that a small group of our members would correspond and identify three key areas that this
collaboration would take. This group met in December 2014 and used the GCG strategy document published
here as a basis for establishing collaboration. We look forward to hearing from this group and for future closer
collaborations between ourselves, SPNHC and NatSCA.
Matthew Parkes
December 2014
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CHALK OR EOCENE ECHINOIDS?
IMPLICATIONS OF A CHANCE OBSERVATION
by Stephen K. Donovan
Donovan, S.K. 2014. Chalk or Eocene echinoids? Implications of a chance
observation. The Geological Curator 10 (2): 67-70.
Accurate and complete data concerning provenance, both locality and horizon, of
geological specimens is naturally considered essential by curators, researchers and
other collectors. But, accidentally, specimens can end up with the wrong
information. Two 'chalk' echinoids purchased by the author in the Isle of Wight are
actually Cenozoic; one, probably both, is Eocene and from the Caribbean region,
most likely, the southeastern USA. Accidents happen, as these specimens would
have sold for more if correctly labelled. An expert second opinion on the provenance
of purchased specimens is never wasted.
Stephen K. Donovan, Department of Geology, Naturalis Biodiversity Center,
Darwinweg
2,
2333
CR
Leiden,
the
Netherlands.
Email
Steve.Donovan@naturalis.nl. Received 7th August 2014. Accepted 14th August
2014.

Introduction

irregular echinoids, labelled as coming from the
Chalk. This provenance was not unexpected for the
island, but the specimens were immediately
recognizable as being in disagreement with this
information. Two specimens (Figures 1, 2) were
brought back to the Naturalis Biodiversity Center for
further investigation because their age and
provenance appeared highly debatable. These
specimens are now registered in the collections of the
Naturalis Biodiversity Center, Leiden, the
Netherlands (prefix RGM).

Rocks and fossils for sale are part of the scenery of
the retail 21st Century. Most museum gift shops sell
geological specimens to their visitors, some of which
may actually be of research interest (Donovan and
Lewis 2004). Rock and fossil shops are specialist
outlets that may be found, particularly, but not
exclusively, in areas of noteworthy geology, such as
the Lake District and the Jurassic Coast.
International rock and mineral shows may attract
curators from wealthier museum, like the Natural
History Museum in London, in search of new
material for research and/or display. Other sources of
specimens may only be available from online
catalogues. Specimens for sale may be local or
imported from exotic locales such as Morocco and
Madagascar, among others. Details of locality and
horizon provided with these specimens are
commonly minimal, but, in my experience, rarely
erroneous. I discuss a notable exception to this
general rule below.

Two echinoids
Both specimens are now identified as Cenozoic,
probably from the Caribbean or south-east USA.
Presumably, neither was well preserved, otherwise
they would not have been polished. Polishing has not
improved their systematic identity and neither is
confidently identifiable below the level of genus. But
their white limey infill is certainly chalk-like in
appearance.
RGM [791 7731**] is the most revealing specimen,
belonging to Oligopygus sp. (Figure 1), a genus of
limited stratigraphic and geographic distribution.
Polishing has obliterated surface detail, such as most
of the tuberculation, but, of the diagnostic features
listed by Smith and Kroh (2011), the following are
still identifiable:
·
"Test of medium size, elongate to subcircular
in outline; margin and adoral surface rounded,
sunken towards peristome" (Figure 1).
·
"Apical system subcentral, monobasal, with

In July 2014 S.K.D. was visiting James Isted's shop,
'Jurassic Jim', in Shanklin, Isle of Wight, in search of
research specimens. For example, the previous year a
fragment of bored wood from the Lower Greensand
Group of the island, found at the bottom of a basket
of Greensand plant remains, had led to a joint
publication (Donovan and Isted 2014). It is always
tempting to contemplate what treasures might lay in
wait in the baskets and boxes of less glamorous
material. Among the specimens that intrigued S.K.D.
on this latest visit was a small collection of polished
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Figure 1. Oligopygus sp. RGM 791 773, Eocene, tropical western Atlantic. (A) Apical view. (B) Oral view. (C)
Lateral view; anterior to right. Scale bar represents 10 mm. Specimens uncoated as this would have masked much
of the remaining morphological data still apparent after polishing.

four gonopores" (Figure 1A).
·
"Petals well developed, open distally,
anterior petal III longest, posterior pair (V & I)
shortest" (Figure 1A).
·
"Peristome subcentral … in deep transverse
depression or trough" (albeit largely obscured by
limestone; Figure 1B).
·
"Periproct inframarginal, midway between
peristome and posterior margin" (Figure 1B).
·
"Tubercles small, irregularly arranged both
adorally and adapically" (best seen in Figure 1B, C).

Globator pratti (Woodward) is similar, features
including the position of the periproct on the
posterior margin, the lack of a transverse trough
about the peristome and inflated test demonstrate that
it is unrelated (Smith and Wright 1999, pl. 119, figs
13-16).
The second specimen, RGM 791 774, is also
presumed to be Eocene, although it represents a
genus with a range of Eocene to Recent. However, it
is conservative to assume that it comes from the
same locality or area as RGM 791 773. Eupatagus
sp. (Figure 2) is a spatangoid (heart urchin) genus
with a global distribution at low to mid latitudes
(Smith and Kroh 2011); it is particularly common in
the Eocene of the Caribbean and southern USA (see,
for example, Arnold and Clark 1927; Cooke 1959).
The posterior is broken and the periproct was
situated in this region. The following diagnostic
features listed by Smith and Kroh (2011) are
identifiable despite the loss of surface detail due to
polishing:

The oligopygids are an extinct sister group to the
clypeasteroids, such as the sand dollars (Mooi 1990),
that are limited geographically to the Caribbean,
south-east USA and Peru (Kier 1967, figure 23).
They are similarly stratigraphically limited and are
only known from the Eocene, having gone extinct
during the Eocene-Oligocene extinction events
(McKinney et al. 1992). Examination of Smith and
Wright (1989-2012) revealed no British Cretaceous
echinoids that were close in morphology to RGM
791 773. Although, for example, the test outline of
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Figure 2. Eupatagus sp., RGM 791 774, presumed Eocene of tropical western Atlantic. (A) Apical view. (B) Oral
view. (C) Lateral view; anterior to right. Scale bar represents 10 mm. Specimens uncoated as this would have
masked much of the remaining morphological data still apparent after polishing.

·
"Test ovate without anterior sulcus" (Figure
2).
·
"Anterior ambulacrum narrow and flush;
pore-pairs small, simple isopores" (Figure 2A).
·
"Other ambulacra petaloid and flush. Petals
distinctly bowed and tapering adapically" (Figure
2A).
·
"Peristome large and kidney-shaped"
(imperfectly seen in Figure 2B).
·
"Some large primary tubercles differentiated
within peripetalous fasciole in interambulacral
zones" (compare small primary tubercles with those
between petals; Figure 2C).

anterior sulcus, a moderately broad anterior
ambulacrum and a more inflated test which is
narrower posteriorly.

Discussion
These specimens are demonstrably not from the
Upper Cretaceous chalk. They bear no close
comparison with any of the many irregular echinoids
known from the Cretaceous of the British Isles
(Smith and Wright 1989-2012) and are undoubtedly
Cenozoic. One specimen is undoubtedly Eocene
(Oligopygus sp.), the other probably so. If this is the
case, they are most probably from the southeastern
USA, where collecting, trading and selling fossils is
more common than in the Antilles. That Jim Isted, a
vertebrate palaeontologist, did not recognize this
discrepancy is not surprising; it may be that the
polisher was similarly misled. Indeed, if the true
provenance has been recognized, they could have

Again, comparison with the British Cretaceous
echinoids revealed no close morphological similarity
to any spatangoid taxon. For example, similarities to
Miotoxaster cf. obtusus Lambert (Smith and Wright
2008, pl. 183, figs 1-4) are superficial, the latter
taxon having a more flattened anterior, shallow
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been sold for more than the local chalk echinoids!
Rather, the mistaken identity created an interesting
holiday investigation for S.K.D. and no harm was
done. Even though the stratigraphic information was
faulty and the implied locality (Isle of Wight) out by
several thousand kilometres, anyone purchasing one
of these echinoids did gain an exotic specimen for
their collection, but most probably unknowingly.

(Cretaceous) of the Isle of Wight and the
problematic ichnology of reworked clasts.
Proceedings of the Geologists' Association 125,
252-254.
DONOVAN, S.K. and LEWIS, D.N. 2004.
Palaeoecology in the museum gift shop.
Proceedings of the Geologists' Association 115,
367-370.
KIER, P.M. 1967. Revision of the oligopygoid
echinoids.
Smithsonian
Miscellaneous
Collections 152 (2), 149 pp.
McKINNEY, M.L., McNAMARA, K.J., CARTER,
B.D. and DONOVAN, S.K. 1992. Evolution of
Paleogene echinoids: a global and regional view.
In Prothero, D.R. & Berggren, W.A. (eds),
Eocene-Oligocene Climatic and Biotic Evolution.
Princeton University Press, Princeton, New
Jersey, 349-367.
MOOI, R. 1990. Paedomorphosis, Aristotle's lantern,
and the origin of the sand dollars (Echinodermata:
Clypeasteroida). Paleobiology 16, 25-48.
SMITH, A.B. and KROH, A. (eds). 2011. The
Echinoid Directory. World Wide Web electronic
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The relevance of this tale to museums is obvious.
Specimens that are being bought for display need to
have the best possible evidence of provenance.
Reference to a recognized expert would be an extra
check that the associated documentation of locality
and horizon is at least plausible. This cautionary
conclusion should apply equally to specimens bought
for sale in your museum's gift shop.
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RECONSTRUCTING RESEARCH NETWORKS:
THE IMPORTANCE OF SIGNED OFFPRINTS
by Stephen K. Donovan
Donovan, S.K. 2014.. Reconstructing research networks: the importance of signed
offprints. The Geological Curator 10 (2): 71-76.
The offprint is in decline as a means of scientific communication in the age of the
pdf, but signed offprints are important sources of data in curatorial and historical
research. In the example of Dr Charles Taylor Trechmann (1885-1964), a researcher
who published only single author papers, with one exception, signed offprints
reinforce our knowledge of his research network and ask questions. Recipients
include authorities entrusted with describing certain specimens collected in the
Antilles (L.F. Spath, T.S. Westoll, T.H. Withers), fellow conchologists (R.B.
Newton) and Caribbean geologists (C.A. Matley), an F.R.S. who may have
nominated Trechmann for fellowship and a seventh individual of unknown
relationship.
Stephen K. Donovan, Department of Geology, Naturalis Biodiversity Center,
Darwinweg
2,
2333
CR
Leiden,
the
Netherlands.
Email
Steve.Donovan@naturalis.nl. Received 8th July 2014. Accepted 14 August 2014

Introduction

geology of New Zealand and the Antilles.
Trechmann was independently wealthy, which
enabled him to fund his fieldwork in exotic locales,
and enabled him to buy adequate offprints of his
papers published in leading journals, particularly
Geological Magazine and Quarterly Journal of the
Geological Society. He also wrote and privately
published monographs on his own theory of
mountain uplift.

The offprint has been an essential part of late 19th
and 20th century academic communication, although
it has now largely been superseded by the pdf
(Petroski 2014). The pdf has many advantages,
including ease of storage and distribution. However,
a pdf, or a hard copy printed from it, lacks the
personal touch. Many authors (myself included)
would, and still do, mail offprints with an
embellishment, such as "To [you] with compliments,
[signature of author]" or similar appellation. Apart
from the loss of this personal touch that is the mark
of the signed offprint, there is also a loss of
information about networks between experts that a
signed copy may provide. This is particularly felt by
the curator and the historian of science, both of
whom may gain valuable data on collections from
the recognition of former academic research
networks. Of the many potential ephemeral and
marginal sources of information available to the
historian (see, for example, Wyse Jackson 1999;
Donovan and Riley 2013), the signed offprint is one
of the most concrete.

I have been collecting Trechmann's papers and
monographs for over 20 years as part of my study of
the history of geological research in Jamaica. I have
photocopies of many papers and some separates cut
from the pages of journals by second-hand
booksellers. But I also have some original offprints
that were signed by Trechmann. These give clues to
his geological network and provide insight into
scientific associations of one prolific author, mainly
between the two world wars.

Charles Taylor Trechmann - a
biographical sketch
Dr. Carl Otto Trechmann (1851-1917), C.T.
Trechmann's father, owned the Warren Cement
Works, Hartlepool, County Durham, and was an
amateur mineralogist. Charles Taylor Trechmann
(Figure 1) studied chemistry and geology at
Armstrong College, Newcastle-upon-Tyne, and at
the Universities of Basel and Paris. He developed a
research interest in the Zechstein of northeast
England, particularly the reef palaeoenvironments,

Charles Taylor Trechmann (1885-1964), D.Sc.,
F.G.S., was a noted amateur geologist and
archaeologist who lived in north-east England, and
who was actively contributing to the scientific
literature between about 1910 and 1960 (Donovan
1999, 2001a, b). Trechmann's principal research
interests were the archaeology, and Permian and
Quaternary geology, of north-east England, and the
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Trechmann's signed offprints
Signed copies of Trechmann's offprints in the
author's collection are addressed to seven recipients
(Figure 2). Two are in a different handwriting from
the others (Figure 2A, E) and it may be that these
were signed by the recipient rather than Trechmann.
Examples illustrated herein will be deposited in the
archives of the Natural History Museum, London.
Fowler. The first on the list (Fig. 2B) remains a
mystery. A. Fowler is not listed by Cleevely (1983),
has not been exposed by web search and, if a
geologist, I have been unable to discover any of his
papers.
Matley. Dr. Charles Alfred Matley (1866-1947) was
a career civil servant and worked in various
departments within the Empire until he retired
(Donovan 2010). He attended evening classes at the
Birmingham and Midland Institute, and Mason
Science College (=the new University of
Birmingham from 1900); geology at Mason College
was taught by Charles Lapworth. Matley graduated
with an external B.Sc. with first class honours of the
University of London in 1894 and subsequently
researched local geology at the weekend; he is best
remembered for his work on the Precambrian and
Lower Paleozoic of northwest Wales (Anon 2006).

Figure 1. Charles Taylor Trechmann (1884-1964), date
of image unknown (after Donovan 2008, fig. 1). Image
provided by Mr. Ian Brown, former Curator, Geological
Museum, UWI, Mona. Other images of Trechmann
were published with an obituary in the British
Northern Daily Mail, 20th February, 1964, p. 9, in
Gage (1993, p. 10) and Donovan (2010, figs 3, 7, 8).

Matley retired in 1920. In 1921 Matley was
appointed to be geologist to the second geological
survey of Jamaica (1921-1924). He had no previous
experience of Antillean geology and no previous
experience as a full-time geologist. But Matley had a
demonstrated expertise in mapping complicated
terrains. The principal purposes of the survey, in
which enterprise Matley was later joined by G. M.
Stockley, seems to have been investigations of water
supply and economic geology. Matley's principal
contributions to Jamaican geology were published
after the demise of the survey, namely his map and
memoir of the geology of the Kingston district
(Matley 1946, 1951), and his postulation of a Basal
Complex in Jamaica and the Antilles (Matley 1929).
The concept of the Basal Complex envisaged a
geological structure analogous to that of the island of
Anglesey and the nearby Lleyn peninsula. Such a
theoretical extension of British geology across the
Atlantic Ocean was not unique (Donovan 2013).
Trechmann directly opposed the Basal Complex
hypothesis with his Theory of Mountain Uplift in
several papers and monographs (e.g., Trechmann
1936b, 1945, 1955, among others; Donovan 2008,
2010).

for which work the University of Durham conferred
the degree of D.Sc.
Trechmann sold the family business to Imperial
Chemical Industries about 1924. His research
programme in the 1920s and 1930s involved work on
the archaeology and geology of north-east England
during the summer months. As winter approached, he
returned to the geologically interesting islands of the
Antilles.
Trechmann published over 80 books and research
papers on geology and archaeology, including at least
40 on the Caribbean (Donovan 2001b). His
individuality often led to an unorthodox approach to
geology. The words of his obituarists - "refreshing
lack of orthodoxy", "scholarship, character, and
individuality" (Fleming and Westoll 1965),
"stimulating and amusing", "unorthodoxy" and
"humour" (Coates 1965) - give a glimpse of the
character of the man. His acts of philanthropy to
scientific institutions were many. Fuller published
accounts of Trechmann's life include Donovan
(2003, 2004, 2008, 2010).
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Figure 2. Details of
signatures, etc., from
offprints of C.T.
Trechmann in author's
collection. (A)
Trechmann (1933). (B)
Trechmann (1932); note
that this paper had an
appendix by T.S. Westoll
(1932).
(C) Trechmann (1936a).
(D) Trechmann (1927).
(E) Trechmann (1948).
(F) Trechmann (1925b).
(G) Trechmann (1923).
(H) Trechmann (1925a).
(I) Trechmann (1922).
(J) Trechmann (1934).
(K) Trechmann (1937).

Newton. Mr. Richard Bullen Newton (1854-1926),
ISO, was an expert on Cenozoic molluscs and
foraminifers (Cox 1926; Woodward 1926) who
worked for the Geological Survey (1868-1880) and
the Geology Department of the British Museum (part
of the British Museum (Natural History) after the
move to South Kensington) (1880-1920). He was a
president of the Malacological Society (1910-1912)
and
Conchological
Society
(1913-1915).
Trechmann's (1923; Fig. 2G herein) paper on the
Eocene molluscs of the Yellow Limestone Group
would presumably have informed Newton's own
research interests.

(1892) and Keeper of Geology (1901), retiring in
1924, the year he received the Wollaston Medal of
the Geological Society. He received many other
awards and served many scientific societies, most
notably being on the Council of the Geological
Society for 33 years (President 1914-1916)
(Woodward 1915; White 1946). But "His time [both
before and after retirement] … was spent not only on
fossil fishes … but also on other vertebrates, about
which he knew much less" (Stearn 1998, p. 235).
This refers mainly to Smith Woodward's notorious
duping by Charles Dawson in the Piltdown Man
hoax (Millar 1972; Russell 2003). Trechmann may
have been nominated by Smith Woodward for
Fellowship of the Royal Society, albeit
unsuccessfully (Donovan 2010, p. 66). It may be in
this connection that Smith Woodward received at
least one offprint for reference (Trechmann 1925a;
Fig. 2H herein) as an account of the Scotland Beds of
Barbados seems outside his interests.

Smith Woodward. Sir Arthur Smith Woodward,
FRS (1864-1944), was one of the most notable
palaeoichthyologists of the 20th Century. He was
appointed an assistant at the British Museum in
1882, before graduating from Owens College,
Manchester, and rose to become Assistant Keeper
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Spath. Dr Leonard Frank (Franz) Spath, FRS (18821957), was a leading expert on Mesozoic
ammonoids. He was employed part-time by the
British Museum (Natural History) and lectured at
Birkbeck College, University of London (Wright
1958; Cleevely 1983, p. 272; Stearn 1998, p. 243).
He described Upper Cretaceous ammonites from
eastern Jamaica that were collected by Trechmann
(Spath 1925). Trechmann (1927, pp. 33-34; Fig. 2E
herein) included cephalopods in a tabulation of
fossils (mainly molluscs) in the Upper Cretaceous
shales of Jamaica.

network are provided by authorities who described
significant specimens that he collected, additional to
those mentioned above (Spath, Withers). Other
notable recipients of Trechmann's munificence were
Herbert Leader Hawkins, FRS (1887-1968)
(University College Reading), who described
Jamaican fossil echinoids (Hawkins 1923, 1924,
1930; Donovan and Lewis 1993), and Henry Dighton
Thomas (1900-1966) who documented sponges and
a coral from the Upper Cretaceous of northern
Trinidad (Thomas 1935).
One source of information for the associations of
most authors is co-authorship, but Trechmann was
unusually independent in his studies, writing but one
joint paper (Trechmann and Woolacott 1919;
Donovan 2001b). When he worked closely with
another researcher, such as Westoll (see above), they
published separately, albeit in close juxtaposition
(such as Trechmann 1932; Westoll 1932). In this
example, Westoll's paper forms a petrological
'appendix' to that of Trechmann.

Westoll. Professor Thomas Stanley Westoll, FRS
(1912-1995), was a distinguished vertebrate
palaeontologist, anatomist and geologist (Patterson
and Fortey 1999; Turner 1999). He was J.B. Simpson
Professor of Geology at the University of Newcastle
from 1948, and a Murchison Medallist and president
of the Geological Society (1972-1974). Yet he first
knew Trechmann when a schoolboy at West
Hartlepool Grammar School. Trechmann was a
frequent visitor to the school, taking groups of
students into the field for an afternoon in his Rolls
Royce (Patterson and Fortey 1999, p. 534). Westoll's
(1932) petrological appendix to Trechmann (1932)
was his first publication, written while Westoll was
an undergraduate at Armstrong College, Newcastle
upon Tyne.

To these records must be added Trechmann's
undoubted myriad, but now anonymous,
acquaintances at the Geological Society and British
Association. Trechmann was also well known to, but
not necessarily well-liked by, the officers of the postwar Geological Survey Division in Jamaica (Chubb
and Williams 2010). He made generous bequests to,
for example, the Geological Society and the British
Museum (Natural History) (Donovan 2010, p. 66).
That he was generous with specimens was
demonstrated to the author when, as a lecturer in
geology at the University of the West Indies in
Jamaica, I was amazed when I found a tray of
pluricolumnals of the British Permian crinoid
'Cyathocrinites' ramosus (Schlotheim) in the
collections, donated by Trechmann; I had
redescribed this taxon a few years earlier (Donovan
et al. 1986).

Withers. Mr. Thomas Henry Withers (1883-1953)
worked as a palaeontologist at the British Museum
(Natural History) from 1898 to 1944 (Stearn 1998,
pp. 239-240). He was an expert on fossil crustaceans,
particularly barnacles. Trechmann supplied Withers
with fossil crustaceans from the Antilles which led to
a series of pioneering papers (Withers 1922, 1924a,
b, 1926a, b, 1927).

Discussion
This list of recipients of Trechmann's offprints is
undoubtedly incomplete; rather, I prefer to
emphasize how much information is provided. Most
of the names on the list were notable
palaeontologists, some of which received specimens
from Trechmann which were described, or, in the
case of Matley, significant figures in the history of
Caribbean geology (Donovan 2010). To this list may
be added Denys B. Smith (1929-2007), who was a
noted expert on the Permian of north-east England
and is known to have received a full set of
Trechmann's offprints from the author (McClean
2008).

Conclusions
The known recipients of Trechmann's offprints are a
mixed bag. Four are predictable, either as co-workers
who published on material that Trechmann had
collected in the Antilles (Spath, Thomas, Westoll) or
a fellow worker on Jamaican geology (Matley). Sir
Arthur Smith Woodward may have been expected to
nominate Trechmann for fellowship of the Royal
Society. Newton was a fellow worker on fossil
molluscs. Only Fowler remains unknown, for now,
but, in the way of such enquiries, is always likely to
be exposed if not by research, then by serendipity.
All add detail to our knowledge of a notable amateur

Further concrete data on Trechmann's research
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geologist and archaeologist who worked mainly on
his own, not in a research group.

Rock Stars, 1823-1971: The Geologists who
Explored Jamaica. Geological Society of
America Memoir 205, 59-78.
DONOVAN, S.K. 2013. Misinterpreting by localism:
transposing European geology and tectonics onto
Jamaica and the Antilles. Proceedings of the
Geologists' Association 124, 530-535.
DONOVAN, S.K., HOLLINGWORTH, N.T.J. and
VELTKAMP, C.J. 1986. The British Permian
crinoid `Cyathocrinites' ramosus (Schlotheim).
Palaeontology 29, 809-825.
DONOVAN, S.K. and LEWIS, D.N. 1993. The H.L.
Hawkins collection of Caribbean fossil echinoids:
annotated catalog of rediscovered specimens
from the University of Reading, England.
Caribbean Journal of Science 29, 186-201.
DONOVAN, S.K. and RILEY, M. 2013. The
importance of labels to specimens: an example
from the Sedgwick Museum. The Geological
Curator 9, 509-514.
FLEMING, C.A. and WESTOLL, T.S. 1965. Charles
Taylor Trechmann. Proceedings of the Geological
Society, London #1628, 207-208.
GAGE, M. 1993. Charles Taylor Trechmann.
Newsletter of the Geological Society of New
Zealand - Historical Studies Group 6, 10-12.
HAWKINS, H.L. 1923.
Some Cretaceous
Echinoidea from Jamaica. Geological Magazine
60, 199-216.
HAWKINS, H.L. 1924. Notes on a new collection of
fossil Echinoidea from Jamaica. Geological
Magazine 61, 312-324.
HAWKINS, H.L. 1930. pp. 215-216. In Trechmann,
C.T. The Manchioneal Beds of Jamaica.
Geological Magazine 78, 199-218.
MATLEY, C.A. 1929. The Basal Complex of
Jamaica, with special reference to the Kingston
district. With petrographical notes by Frank
Higham, M.Sc., A.R.S.M., F.G.S. Quarterly
Journal of the Geological Society, London 85,
440-492.
MATLEY, C.A. 1946. Outline of the Geology of the
Kingston district of Jamaica. Institute of Jamaica,
Kingston, published by the Crown Agents of the
Colonies, London, 4 pp.
MATLEY, C.A. (ED. RAW, F.). 1951. Geology and
Physiography of the Kingston District, Jamaica.
Institute of Jamaica, Kingston, published by the
Crown Agents of the Colonies, London, 139 pp.
McLEAN, S. 2008. Obituary. Denys Barker Smith
1929-2007. Proceedings of the Yorkshire
Geological Society 57, 131-132.
MILLAR, R. 1972. The Piltdown Men. St. Martin's
Press, New York, 264 pp.
PATTERSON, C. and FORTEY, R.A. 1999. Thomas

Acknowledgements
I thank Mike Simms (National Museums of Northern
Ireland) for his supportive review.

References
ANON. 2006. The Harlech Dome. Geology Today
22, 95, 97.
CHUBB, L.J. and WILLIAMS, J.B. 2010. Professor
Verners Aleksandrs Zans (1904-1961). In
Donovan, S.K. (ed.), Jamaican Rock Stars, 18231971: The Geologists who Explored Jamaica.
Geological Society of America Memoir 205, 79101.
CLEEVELY, R.J. 1983. World Palaeontological
Collections. British Museum (Natural History)
and Mansell Publishing, London, 365 pp.
COATES, A.G. 1965. Obituary of Dr. Charles Taylor
Trechmann, D.Sc., F.G.S. Journal of the
Geological Society of Jamaica 7, 48-49.
COX, L.R. 1926. Obituary. Mr. R.B. Newton, I.S.O.,
F.G.S. Geological Magazine 63, 144.
DONOVAN, S.K. 1999. An annotated bibliography
of papers on the geology of northeast England by
Charles Taylor Trechmann: Part 1 - Quaternary.
The Vasculum 84 (3), 4-18.
DONOVAN, S.K. 2001a. An annotated bibliography
of papers on the geology of northeast England by
Charles Taylor Trechmann: Part 2 (conclusion) mainly Permian. The Vasculum 86 (1), 37-43.
DONOVAN, S.K. 2001b. The publications of
Charles Taylor Trechmann (1885-1964), a notable
amateur geologist from the northeast of England.
The Vasculum 86 (3), 21-25.
DONOVAN, S.K. 2003. Charles Taylor Trechmann
and the development of Caribbean geology
between the wars. Proceedings of the Geologists'
Association 114, 345-354.
DONOVAN, S.K. 2004. Trechmann, Charles Taylor,
pp. 249-250. In Matthew, H.C.G. & Harrison, B.
(eds), Oxford Dictionary of National Biography,
Volume 55, Tonson-Usher. Oxford University
Press, Oxford.
DONOVAN, S.K. 2008. The 'Forbidden Theory of
Mountain Uplift' of Charles Taylor Trechmann
(1884-1964): a tectonic theory of the 1950s in
context. Geological Journal 43, 605-619.
DONOVAN, S.K. 2010. Three points of view:
Wendell P. Woodring (1891-1983), Charles A.
Matley (1866-1947), Charles T. Trechmann
(1884-1964), and Jamaican geology in the 1920s
and 1930s. In Donovan, S.K. (ed.), Jamaican
75

Stanley Westoll 3 July 1912-19 September 1995.
Biographical Memoirs of Fellows of the Royal
Society, London 45, 531-546.
PETROSKI, H. 2014. In memory of the offprint.
American Scientist 102, 14-17.
RUSSELL, M. 2003. Piltdown Man. The Secret Life
of Charles Dawson & the World's greatest
archaeological Hoax. Tempus Publishing, Stroud,
Gloucestershire, 288 pp.
SPATH, L.F. 1925. On Senonian ammonites from
Jamaica. Geological Magazine 62, 28-32.
STEARN, W.T. 1998. The Natural History Museum
at South Kensington. Natural History Museum,
London, xxiii+414 pp.
THOMAS, H.D. 1935. On some sponges and a coral
of Upper Cretaceous age from Toco Bay,
Trinidad. Geological Magazine 72, 175-179.
TRECHMANN, C.T. 1922. The Cretaceous and
Tertiary question in Jamaica. Geological
Magazine 59, 422-431.
TRECHMANN, C.T. 1923. The Yellow Limestone
of Jamaica and its Mollusca. Geological
Magazine 60, 337-367.
TRECHMANN, C.T. 1925a. The Scotland Beds of
Barbados. Geological Magazine 62, 481-504.
TRECHMANN, C.T. 1925b. The Northern Range of
Trinidad. Geological Magazine 62, 544-551.
TRECHMANN, C.T. 1927. The Cretaceous shales of
Jamaica. Geological Magazine 64, 27-42, 49-65.
TRECHMANN, C.T. 1932. Notes on Brimstone Hill,
St. Kitts. Petrology by T.S. Westoll. Geological
Magazine 69, 241-258.
TRECHMANN, C.T. 1933. The uplift of Barbados.
Geological Magazine 70, 19-47.
TRECHMANN, C.T. 1934. Tertiary and Quaternary
beds of Tobago, West Indies. Geological
Magazine 71, 481-493.
TRECHMANN, C.T. 1936a. Mesolithic flints from
the submerged forest at West Hartlepool.
Proceedings of the Prehistoric Society for 1936,
Paper No. 7, 161-168.
TRECHMANN, C.T. 1936b. The Basal Complex
question in Jamaica. Geological Magazine 73,
251-267.
TRECHMANN, C.T. 1937. The base and top of the
coral-rock in Barbados. Geological Magazine 74,
337-359.
TRECHMANN, C.T. 1945. The West Indies and the
Mountain Uplift Problem. Privately published,
Castle Eden, Co. Durham, 25 pp.
TRECHMANN, C.T. 1948. The West Indies and the
mountain uplift problem. Part II. Additional
observations. Privately published, Castle Eden,
Co. Durham, 31 pp.
TRECHMANN, C.T. 1955. The British Association

for the Suppression of Science or A New
Explanation of Mountain Uplift, Based on Lunar
Gravitation and Ocean Pressure. Privately
published, Castle Eden, Co. Durham, 64 pp.
TRECHMANN, C.T. AND WOOLACOTT, D.
1919. On the highest Coal-Measures or "Zone" of
Anthracomya phillipsi in the Durham Coalfield.
Geological Magazine 56, 203-211.
TURNER, S. 1999. Westoll, Thomas Stanley. In
Singer, R. (ed.), Encyclopedia of Paleontology,
Vol. 2, M-Z. Fitzroy Dearborn Publishers,
Chicago, 1338-1341.
WESTOLL, T.S. 1932. Description of rock
specimens from Brimstone Hill and three other
localities in St. Kitts, B.W.I. Geological
Magazine 69, 259-264.
WHITE, E.I. 1946. Sir Arthur Smith Woodward
[obituary]. Proceedings of the Geological Society
101, xliii-xlvi.
WITHERS, T.H. 1922. On a new brachyurous
crustacean from the Upper Cretaceous of
Jamaica. Annals and Magazine of Natural History
(series 9) 10, 534-541.
WITHERS, T.H. 1924a. Some Cretaceous and
Tertiary decapod crustaceans from Jamaica,
Annals and Magazine of Natural History (series
9) 13, 81-93.
WITHERS, T.H. 1924b. Decapod crustaceans from
the Oligocene of Anguilla. Annals and Magazine
of Natural History (series 9) 14, 225-233.
WITHERS, T.H. 1926a. Barnacles of the CreusiaPyrgoma type from the Pleistocene of Barbados.
Annals and Magazine of Natural History (series
9) 17, 1-11.
WITHERS, T.H. 1926b. Decapod crustaceans
(Callianassa) from the Scotland Beds of
Barbados. Geological Magazine 63, 104-108.
WITHERS, T.H. 1927. Ranina trechmanni, a new
Cretaceous crab from Jamaica. Geological
Magazine 64, 176-180.
WOODWARD, B.B. 1926. Obituary. Richard Bullen
Newton, I.S.O., F.G.S., etc. Proceedings of the
Malacological Society, London 17, 69-70.
WOODWARD, H.B. 1915. I.-Eminent living
geologists. Arthur Smith Woodward, LL.D. (St.
Andrews, Glasgow), F.R.S., F.L.S., F.G.S., F.Z.S.,
F.R.G.S., Keeper of the Department of Geology,
British Museum (Natural History). Geological
Magazine 52, 1-5.
WRIGHT, C.W. 1958. Leonard Frank Spath.
Proceedings of the Geologists' Association 69,
70-71. [Obituary.]
WYSE JACKSON, P.N. 1999. Geological museums
and their collections: rich sources for historians of
geology. Annals of Science 56, 417-431.
76

GEOLOGICAL CURATORS' GROUP SURVEY 2014:
RESULTS AND A VISION FOR THE FUTURE
by C. Giles Miller1, Tim Ewin1, Hannah-Lee Chalk2 , Kathryn Riddington3,
Helen Kerbey4, Cindy Howells4, John Nudds5, Matthew Parkes6,
Jim Spencer7, Tony Morgan8, Mike Howe9, Emma Bernard1,
Sarah King10 and Isla Gladstone11
Miller, C.G. et al. 2014. Geological Curators' Group Survey 2014: results and a
vision for the future. The Geological Curator 10 (2): 77-92.
In early 2014 the GCG carried out an on-line survey to investigate: the present status
of geological curators, potential networking with other groups, support levels for
electronic delivery of our journal and newsletter, subjects requested for future
workshops/training events, the need for a database of natural history collections,
how to deliver skills sharing networks and future GCG activities. It would appear
that most geological collections are managed by curators with additional subject
specialist areas of responsibility but there is a core of experienced geological
curators in the UK with responsibilities for large collections. Direct e-mailing and
our JISCmail list are the best method for communication within our group. The
largest overlap in our membership is with NatSCA but members listed 45 other
organisations with 91% of the total responses welcoming closer links with other
natural science collection organisations. A list of subjects are presented here that can
act as a basis for planning future programmes and skills sharing networks. There
were many requests for low-level training as well as for advice on specimen
conservation issues. 74% would consider receiving a pdf and not hard copy of
Geological Curator but this was higher for Coprolite (88%). Only 64% said that
they see GCG as the first port of a call to answer questions on the management and
use of geological collections. 'A louder voice for advocating geological collections'
was considered the most important future role for the GCG. Finally 12 major action
points summarising our proposed direction over the next three years are presented.
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Introduction

collections or with an interest in the management of
geological collections. We circulated an invitation to
fill out the survey on both the GCG and Natural
Sciences Collections Association (NatSCA)
JISCmail lists, on our Facebook and Twitter feeds as
well as by e-mailing all members that we have on our

In February 2014 we circulated and solicited
responses to a Google Docs survey aimed at
investigating stakeholder requirements from the
GCG. The survey was not aimed specifically at GCG
membership, but those managing geological
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database. This was aimed mainly at a UK and
European audience but there are some members and
subscribers to these lists outside Europe, mainly
from North America. The Google Docs survey link
was shortened to http://bit.ly/O2Ooeg by registering
it on-line with Bitly (https://bitly.com/). This allowed
us to download on-line statistics about the timing of
visits to the link, country of origin of replies and
therefore evaluate the more successful methods for
dissemination of information to our members.
Adverts placed on JISCmail, Facebook and Twitter
were deliberately separated by at least 5 days so that
we could assess the effect of various methods for
communication.

What is your current status?
-Geological Curator
-Natural Science Curator of a collection that includes
Geological specimens
-Researcher with interest in Geological Collections
-Retired
-Other (please state)
How long have you been managing geological
collections?
< 1year
1-5 years
5-10 years
10-20 years
>20 years
n/a

The intention of the survey was to ask questions on
the following broad topics: background of
respondents, networking with other groups,
delivering information by our journal and newsletter,
subjects requested for workshops/training events,
databases of natural history collections, skills sharing
networks, future GCG activities.

Meetings:
Do you attend GCG Meetings and events? Y/N
If yes, which of the following? (multivalued answers
possible)
-AGM
-Workshops/training sessions
-Study visits

The results were analysed as two subsets, one for
data relating only to GCG members and another for
the whole dataset. The results of the survey are
presented here, with the full details (minus personal
details such as e-mail addresses) published online
with
Figshare
at
http://dx.doi.org/10.6084/m9.figshare.1251302. The
results are discussed and a future strategy for the
GCG presented.

If not, please indicate why? (multivalued answers
possible)
-Not relevant to my job
-Too expensive
-Lack of support from institution
-Other (please state)
What would encourage you to participate more often in
GCG events? Free text

The survey questions

Are there any subjects that you would like to see us cover
as part of our programme? Free text

Background:

Publications:

Do you manage geological collections? Y/N

Do you read Geological Curator? Y/N

If yes, what size are your geological holdings?
<500
500-1,000
1,000-5,000
5,000-10,000
10,000-100,000
>100,000

Do you read Coprolite? Y/N
Subscriptions may need to be raised, but a reduced rate
would be offered for people who only receive pdfs of
publications. Would you consider subscribing to
electronic copies of Coprolite? Y/N

Do you or anyone else on your staff have geological
training or background? Y/N

Subscriptions may need to be raised, but a reduced rate
would be offered for people who only receive pdfs of
publications. Would you consider subscribing to
electronic copies of Geological Curator? Y/N

If yes, what is your/their employment status?
-Full time
-Part time
-Mixture of full and part time staff
-Volunteer
-N/a
-Other (please state)

Would you like to comment on our suggestion to deliver
our publications electronically? Free text
What topics would you like to see covered in GCG
publications? Free text
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Other organisations:

What subjects/areas of museum work would you be
prepared to offer advice on e.g. collections management,
mineral identification, fossil identification, hazards,
conservation, display, outreach, digitisation? Free text

Are you a member of the following? (multiple options
possible)
-GCG
-NatSCA
-SPNHC
-HOGG
-Russell Society
-Other (please specify)

Future GCG activities:
How do you see the role of the GCG in the future? Please
place the following in order of preference:
Organising study trips
Organising training seminars
Publishing ideas and advice in Geological Curator
Keeping members informed of latest happenings in
geological collections management
Monitoring and providing support for collections/staff at
risk
A louder voice advocating geological collections

Would you welcome a closer relationship between the
GCG and these other natural science collections
organisations? Y/N
How would you like to see these collaborations happen
(meetings, joint projects etc)? Free text

Is there anything that the GCG are not currently doing that
you would like to see us supporting? Free text

Would a database of natural science collections, for
example an updated FENSCORE, be useful for your
work? Y/N
Comments: Free text

Thank you for taking part in this anonymous survey we
hope to publish the results shortly.

Advice:

Communication

Do you see GCG as the first port of a call to answer
questions on the management and use of geological
collections? Y/N

Results

Which of the following would you most likely seek advice
for? (put the following in order of preference)
-Providing valuations for insurance purposes
-Conservation issues
-Expert identifications
-Storage solutions

There were a total of 113 replies to the survey, half of
whom responded after the initial requests over the
two JISCmail lists. Facebook and Twitter adverts
produced a much lower hit rate to the survey as did
an e-mail sent out to our whole membership. During
the time that the survey was live there were 215 hits
on the bitly link so just over half of the visits to the
survey form resulted in data being sent to us (Figure
1).

Are there any other areas not included above? Free text

Discussion

How would you like to access such advice? (multivalues
possible)
-Professional working parties ("Geoblitzes") organised by
the GCG
-On-line list of experts to contact with their expertise
listed
-On-line site where requests can be logged and an
administrator decides who to delegate questions to?
-On-line factsheets
-Workshops or training courses
-Other (please state in comments)

The main communication outcome from this survey
is that e-mail distribution lists such as the JISCmail
list or mass e-mailing of our membership are key
methods for communication within our group of
specialists. The data is slightly skewed because this
was the first method for dissemination of details of
the survey so subsequent adverts using other media
(Facebook, Twitter) may not have appeared to have
been so successful. However, several respondents
replied that JISCmail would be their first port of call
for requesting specialist information about
geological curation. Another reason may be the
fledgling nature of the Twitter and Facebook
accounts and the relatively low number of followers
at the time of the survey. The recent
SPNHC/NatSCA/GCG meeting in Cardiff is a very
good example of how these new forms of
communication have served to enhance the profile of
the GCG. Although these formats may not be

If no, where would you normally go? Free text field

Comments. Free text.
Would you be prepared to join a list of members willing to
offer expert advice? Y/N
If yes, please leave your e-mail address for us to contact
you. If you wish the answers in this questionnaire to
remain anonymous then you can volunteer for the skill
sharing
database
by
e-mailing
geologicalcuratorsgroup@gmail.com.
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Figure 1. Traffic on the Bitly link used to disseminate the survey. The four main peaks relate to: initial listserver
adverts (GCG and NatSCA), Facebook (6th March), e-mail to all members (11th March) and final reminder
listserver advert (April 8th). Only 5 clicks came from two separate tweets.

reaching the majority of our membership, they are
still a very effective method for wider
communication of the activities of the GCG.

or technician roles.
88% of replies indicated that either the respondent or
someone else on the staff has geological training or
background.
88% of all respondents replied that their collections
were over 10,000 specimens in size with 40% of the
total saying that the number of specimens they
managed exceeded 100,000.
56% replied that they had been managing geological
collections for over 10 years with 33% of the total
having managed geological collections for over 20
years. Only 13% had been managing geological
collections for fewer than 5 years.

Future
· Maintain an up to date list of member e-mails for
better communication with our membership.
· Encourage a wider engagement of our membership
with the JISCmail list by analyzing who is currently
subscribed and encouraging those not currently
signed up to do so.
· Advertise the JISCmail list to those that are
currently non-members.
· Encourage membership via the JISCmail to follow
us on Twitter and Facebook.

62% replied that their museums had full time
Geological Curators and with 13% saying a mixture
of full and part time, a total of 75% of museums had
at least one full time geological curator. Part time
accounted for only 6% but the number of
respondents that mentioned volunteers was 11%.
Other answers included retired (3%) and others (5%
of total) replied that they were not employed as
curators but gave advice, were honorary curators,
museum trustees or freelance.
82% of respondents answered from the UK, but
replies came from 15 different countries, mainly
from Europe and North America (Figure 3).

Background of respondents
Results
74% of respondents replied that they manage
geological collections with 33% Geological
Curators, 16% Natural Science Curators of a
collection that includes geological specimens, 8%
Researchers with an interest in geological collections
and 5% retired.
A total of 45 other job titles were given with the
spread reflecting education, exhibition, conservation,
preparation, museum directorial, visit management
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Figure 2. Job titles (A),
collection sizes (B),
employment status (C)
and length of time
managing collections
(D) of respondents. The
outer rings show GCG
member data and the
middle rings the dataset
as a whole.

Figure 3. Distribution of hits on the Bitly link (http://bit.ly/O2Ooeg).
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Discussion

travel distance (33% of all answers). Lack of support
from institution (11%) and not relevant to job (10%)
were next with 20% covering 17 different additional
reasons. Interestingly, the most common additional
reason outside of the tick boxes was that usually they
would rely on colleagues to attend (5%). Lack of
time and cost were both 8% with not receiving
information on events only 5% of the total.

The survey seems to have been filled in mainly by
those who currently manage geological collections
rather than those with an interest in managing
geological collections and this probably reflects that
the survey was sent directly to our membership. A
total of 45 different job titles and a total percentage
of 33% solely managing geological collections
suggests unsurprisingly that most geological
collections are managed by curators with additional
subject specialist areas of responsibility. However, it
was interesting to see that only 16% described
themselves as natural science curators of a collection
that includes geological specimens. Job titles are
notoriously
unstandardised
for
museum
professionals with one person doing a similar role in
another museum having a very different job title so
this may not be significant. Alternatively it may just
show that we failed to encourage this group of
collections managers to respond. One trend that does
come across clearly is that there is a core of
experienced geological curators in the UK with
responsibilities for large collections.

When free text answers were taken into account, the
lack of time and money were much more to the fore
particularly when all respondents were asked 'what
would encourage them to participate more often in
GCG events?' There were a range of answers given
to the question 'Are there any subjects that you would
like to see us cover as part of our programme?' and
these have been incorporated into a set of subjects
requested. These are reproduced in table 1.

Discussion
The total numbers of respondents who have attended
a GCG event are disappointingly low, especially
when the results included only GCG members. Only
a third of respondents had been to a GCG AGM and
as few as a fifth had been on a study visit. The free
text descriptions perhaps give more details as to why
this should be with the check box answers indicating
that distance of travel is perhaps the overriding
reason for non-attendance. Figure 4 gives details of
the location of our UK membership and would
indicate that a central location (Nottingham,
Birmingham) is within easy reach of the majority of
our membership. This does not take into account our
overseas members so we should look into methods
for engaging them with our meetings. It is interesting
to see Integrated Digitized Biocollections (iDigBio)
regularly holding web seminars so this may be an
area to look into. It does not appear that the actual
cost of the GCG meetings is putting people off,
although the free text answers again would suggest
that the total cost of travelling etc is a factor leading
to lack of attendance. Lack of time available is also a
key factor. Very few people cited lack of relevance of
meetings as reasons for non-attendance, but there
were a few answers that suggested that if we made
our meetings more widely relevant then we might
have greater attendances. It would have a knock-on
effect with institutions more likely to support their
staff to attend if meetings were more applicable and
key skills directly transferrable to jobs. Requests for
low-level training e.g. identifying minerals,
managing geological collections, were conspicuous
in their presence. However, the data is not
quantitative so we should publish our list of possible
subjects and see what the most popular events are
before deciding on future strategies.

The request for status of staff included a multivalued
option so not too much can be inferred from the data
other than to say that 75% of museums had full time
curatorial staff in charge of their geological
collections. The numbers for volunteers (11%) were
higher than for part time (6%).

Future
· Future surveys aimed at a non-specialist audience
so that we can find out what they require from us.
· Make sure that the core of specialist geological
curators are fully engaged with our activities so that
they can pass on their knowledge and experience to
future geological collections managers.
· Introduce Paypal to make it easier for new
members to pay, particularly those from overseas. It
will also make it easier for members to keep up to
date with paying their subs.

Meetings
Results
Only 58% of GCG member respondents replied that
they attend GCG meetings and events and the figure
was only 42% when the whole dataset was
considered. 47% have attended workshops/training
sessions with AGM (33%) and study visits (20%)
less well attended.
Multivalued answers available only to those who
indicated that they do not attend GCG meetings
showed that the main reason for non-attendance was
82

northern members).
· Make a list of previous seminar and workshop
titles so we can assess which were successful and rerun them.
· Record training and make the sessions available
via the webpage, YouTube or do webinars so that
members from further regions in the UK and abroad
can participate.
· Post hand-outs from training onto our web page.
· Develop an online course (MOOC = Massive Open
On-line Course).
· Look at the possibility of funded travel bursaries
by applying for external funds.
· Make people attending meetings for the first time
feel especially welcome so they encourage their
colleagues to attend.
· Seek funds to support a travel bursary.

Publications
Results
The main questions asked related to whether we
should deliver our publications electronically in
future. When asked if respondents read Geological
Curator, only 79% said yes although this was 97%
when only GCG members were considered. The
results were almost identical for the same questions
about Coprolite. 71% of members (74% of whole
dataset) answered that they would consider a reduced
rate of subscription if a pdf and not hard copy of
Geological Curator were sent to them. Answers on
electronic publication were more conclusive when
the same question was asked about Coprolite with
88% of members considering receiving a pdf and a
reduced rate of membership. 12 members who
answered no to Geological Curator going to pdf
answered yes to Coprolite going electronic.

Figure 4. Dot map showing the location of our
Members (6 Honorary and 190 Individual but
excluding 97 Institutional).

Future
· We should aim to increase the percentage of
members who attend our meetings. Some possible
ways are listed here:
· Better advertising via JISC mail, Coprolite,
GeolSoc newsletters, and other JISC mail (e.g.
NatSCA, GEM, HOGG, etc.) with plenty of notice.
· Plan event programme over a year in advance, so
that people can put dates in diaries.
· Have another survey to get some more quantitative
data on what subjects people want covered based on
the list given in Table 1.
· Choose subjects that are applicable to a wide
audience.
· Send round the list of possible subjects to
membership and other organisations who might
participate in joint meetings. These might include
HOGG, GEM, Geoconservation UK, University
Museums Group and regional museum development
groups as well as those that we currently engage with
(NatSCA,
SPNCH,
SVPCA/SPPC,
Royal
Microscopical Society).
· Look into holding both specialist and nonspecialist events.
· Hold most meetings in more central and accessible
areas e.g. Birmingham, Nottingham.
· Re-run workshops so that more members have the
opportunity to attend (ie we should schedule
workshops for different dates for southern and

When comments in the free text field were taken into
consideration, there would appear to be some
members who wish to retain the option to receive
hard copy of both Coprolite and Geological Curator
with many comments very positive towards this
potential move. Some questioned the long-term
stability of keeping publications electronically and
called for a more stable method for archiving.

Discussion
While it would seem that moving to providing pdf
copies of Coprolite is inevitable, the message about
our journal Geological Curator is not as conclusive
and offering the chance to receive paper copies looks
set to continue. Topics requested for inclusion in the
journal include conservation related papers (see word
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cloud Figure 5 below). Again these subjects have
been added to the list of topics that could be offered
as journal articles, workshop titles or future AGM
topics (Table 1 - see page 90).

of most subscribed: GCG (72), NatSCA (45, of
which 31 were both NatSCA and GCG members), no
other groups (15), History of Geology Group (13),
SPNHC (11), The Palaeontological Association (8),
The MA (5), The Geological Society (4), The
Geologists' Association (4) and the Society for
Vertebrate Palaeontology (4) (Figure 6). 36 other
groups were listed by survey participants but none of
them more than once. Some interesting names
occurred amongst these 36 including GEM
(Geoscience for Environment Management) and
SHARE.
When asked if those completing the survey would
welcome a closer relationship between the GCG and
these other Natural Science Collections
organisations, 102 replied yes with only 10 saying
no. This equates to a positive response from 91% of
the total replies with this figure dropping slightly to
89% when only GCG members were considered. The
most common method for delivering these links was
by holding joint meetings. Engaging in collaborative
projects was another suggestion that appeared on
several occasions (Figure 7).

Future
· Electronic publishing of both Coprolite and
Geological Curator.
· Members retain the option to receive paper copies
of either.
· Make it clear where the money saved is being used
so that value of membership is retained.
· Investigate methods for safe archival and delivery
of electronic versions of both our newsletter and

Figure 5. Word cloud taken from the free text request
for information about subjects survey respondents
would like to see covered in our journal.

journal.
· We have asked our membership so we should
investigate how our 97 Institutional members might
respond to a move to electronic publication.
· Re-establish an ICON rep on GCG committee so
that we can strengthen our links with geological
conservators.
· Encourage more participants in GCG meetings to
submit journal and newsletter articles.

Figure 6. Pie chart showing the related groups that
survey respondees are members of.

A question relating to a database of natural history
collections was included here as it is a current project
where NatSCA and GCG can collaborate. 86% said
that such a database would be helpful for their work.
The Word cloud included "Cleevely" and not so
many chose to comment on FENSCORE.

Networking with other groups

Discussion

Results

As suspected there is largest overlap in membership
between GCG and NatSCA with 31 survey
respondents reporting to be members of both.

The survey requested details of other groups to
which members subscribe. These included, in order
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Figure 7. Word cloud
showing the free text
field for the question
'How should we
collaborate?'

· Make efforts to network with mineralogical
groups.
· Work with NatSCA towards #naturedata project by
supplying information about collectors and
collections present in the Cleevely Book "World
Palaeontological Collections".

Undoubtedly there are more than 31 members who
subscribe to both organisations. The overlap between
GCG and SPNHC is less well represented and this
could be something that we could develop following
the signing of the MoU between SPNHC, NatSCA
and GCG at the 2014 SPNHC AGM in Cardiff. Other
low numbers include The Geological Society and the
Geologists' Association so we could try harder to
forge links with these organisations. The
Palaeontological Association, Society for Vertebrate
Palaeontology and other fossil based organisations
had a good representation and may indicate that our
membership has more of a palaeontological than a
mineralogical bias as strangely nobody admitted to
being a member of the Russell Society. One
possibility is that respondents felt that they had to
limit their replies to the options given in the survey
and did not mention other groups. However, there are
certain trends that stand out relating GCG, NatSCA
and HOGG and we should make make efforts to
arrange joint meetings with these groups. We should
also make efforts to forge links with SPNHC and the
Geological Society despite the perceived lack of
cross over between our membership.

Advice
Results
Amongst survey respondents, only 64% said that
they see GCG as the first port of call to answer
questions on the management and use of geological
collections. Predictably the percentage amongst
members was higher at 75%. A word cloud (Figure 8)
for data relating to the question, 'where would you
normally go for advice?' included 'NatSCA' and
'colleagues' as largest letters but quite a few people
mentioned listservers under a number of different
guises (JISCmail, GCG and NatSCA lists, listserver,
e-mail list).
58% said they would consider becoming part of a
skills sharing network and when only GCG members
were considered, this figure was higher at 65%. 30
survey respondents left their e-mails so that they
could be contacted at a later date to become part of a
skills sharing network.
Four potential options were given for areas where
advice may be requested. Most respondents said that
providing valuations for insurance purposes was
either unlikely or very unlikely to be requested.
'Conservation issues' and 'expert identification' were
listed as either quite or very likely to be requested
while 'advice on storage solutions' was mainly quite
likely or unlikely to be requested (Figure 9). Details
from the free text field asking for other subjects that
could be included for advice have been synthesized
into the list of topics (Table 1).

A database of Natural History collections appears to
be a popular move with survey respondents. Some
suggested that we make use of Ron Cleevely's book
in which he lists world Palaeontological Collections.

Future
· Set up a SPNHC, NatSCA, GCG working party
following the signing of the MoU at the 2014
SPNHC meeting in Cardiff.
· Apply for grants to support networking.
· Forge stronger links with the Geological Society by
participating in their activities such as "Earth Science
Week".
· Contact all of the other groups mentioned with
details of the GCG (what we can offer and how to
join) and offer to make a link from our website.
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Three methods for delivering advice came out
roughly equal with roughly half of the total
respondents requesting 'on-line factsheets',
'workshops or training courses' or 'an on-line list of
experts to contact with their expertise listed'. Other
methods that scored less highly were 'Professional
working parties ("Geoblitzes") organised by the
GCG', an 'on-line site where requests can be logged
and an administrator decides who to delegate
questions to' and finally the 'I have no preference'
category. Categories lists under 'other' included the
JISCmail group, a forum monitored by GCG
specialists, online instructional videos - e.g hosted by
YouTube, our website or simply via a colleague who
is a member.

Discussion
The percentage of people suggesting that the GCG
would be their first port of call for answering
questions relating to the management of geological
collections is disappointingly low. We need to
increase this percentage and creating a skill sharing
network for advice on geological collections
management would be the best way forward. The
survey gives a clear steer that providing a list of
members and their areas of expertise is the most
popular way to provide this service, although it is
clear that providing short and snappy advice leaflets
would also be a good way of delivering advice
quickly and easily. A number of other methods
including providing instructional videos on YouTube
have been suggested and these are clearly methods
that museums are currently using to provide
guidance or to advertise their projects or expertise.

Figure 8. 'Where would you go for advice on geological
collections management?' Word Cloud.

Figure 9. (A) Bar chart showing relative importance of advice subjects for the whole dataset. The details when
GCG members were considered on their own was identical. (B) chart showing how respondees thought the advice
should be delivered. The GCG members only data is in the middle ring and the data relating to the whole dataset on
the outer ring.
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It is interesting to see that providing valuations for
insurance purposes scores so lowly on the scale of
subjects for which advice is sought considering this
was something suggested by the state and status
report published in 2005 (Fothergill 2005). It raises
an issue that this may still not have judged the exact
requirements for our membership or those managing
geological collections. The free text nature of this
survey does not give very much quantitative
information. Another survey using the list of skill
and requirements identified by his survey might give
more information about how many people want
information about particular skills.

· Host on-line factsheets by publishing Guidelines to
Geological Curation as bite sized pdfs on our
website.
· Produce short YouTube videos on areas where
most advice is needed.
· Continue to run relevant workshops or training
courses.
· Run a mentoring scheme.
· Seek funds to support internships.
· Participate in initiatives that support short term
exchanges or visits (e.g. UK Consortium of Natural
History Museums).

Future

Future direction

· We need to increase the percentage of people who
would come to us for advice on managing geological
collections. Some suggestions to improve this would
include:
· Set up a skills sharing network by circulating the
list of topics (Table 1) and asking if people would
provide support or need support under each of the
categories?
· Develop our website so that there are clear pointers
to how advice can be obtained (a new tab "Advice"
has already been created).
· Host an on-line list of experts to contact with their
expertise listed.

Results
Six different options were given for the question
'How do you see the role of the GCG in the future.
Five of these rated 'important' or 'vital' for over 80%
of respondents (Figure 10):
Organising training seminars
Publishing ideas and advice in Geological Curator
Keeping members informed of latest happenings in
Geological Collections Management
Monitoring
and
providing
support
for
collections/staff at risk
A louder voice advocating geological collections

Figure 10. How respondees see the future role of the GCG. (Whole dataset)
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The most obvious signal was that organising study
trips was not considered vital whereas 'a louder voice
for advocating geological collections' was
considered the most important future role for the
GCG. Those responding to the organising study trips
question rated this function with a fairly even spread
between not that important, quite important and
important.

encourage good standards of collections
management.
· Facilitate dialogue between museums and
professional fossil collectors.
· More blogs advocating the use of geological
collections.

The free text data relating to other areas that the
GCG should aim to be a positive voice advocating
geological collections and being proactive at a higher
level, lobbying ACE, MPs and local government.
Many responses were positive about how the GCG
are currently operating.

The previous sections have provided many
suggestions for future direction and activity of the
GCG based on the response from our 2014 survey.
Here are 12 major action points that summarise our
proposed direction over the next three years:

Conclusions

1.
Encourage members to communicate with us
via our JISCmail list and to follow us on Twitter and
Facebook.
2.
Use the table of potential topics presented
here (Table 1) as a basis for another survey to gather
quantitative data on meeting subjects and as basis for
a skills sharing network.
3.
Build on the signing of the Memorandum of
Understanding (MoU) with SPNHC and NatSCA by
collaborating and providing a combined and unified
approach to tackling many of the activities
mentioned in this report.
4.
Investigate building better links with other
closely related societies, particularly The Geological
Society and HOGG.
5.
Plan our meetings programme for at least a
year in advance and encourage attendance by:
- Choosing subjects applicable to a wide audience
- Choosing easily accessible venues
- Developing a targeted advertising campaign
- Collaborating with other organisations to choose
relevant subjects (initially SPNHC, NatSCA)
- Holding both specialist and non-specialist events
- Re-running successful events in different parts of
the country
- Applying for money so we can award travel
bursaries
6.
Record training and make the sessions
available via the webpage, YouTube or webinars so
that members from further regions in the UK and
abroad can participate.
7.
Develop an on-line course (MOOC).
8.
Publish both Coprolite and Geological
Curator electronically as pdfs with paper copies still
available on request.
9.
Re-establish an ICON rep on GCG
committee so that we can strengthen our links with
geological conservators.
10.
Increase the percentage of people who would
come to us for advice on managing geological
collections by:

Discussion
The previous sections have covered many of the
ways in which the GCG have been operating and will
be operating in the future. It may be because these
areas were covered in previous sections that
comments were limited here. Many comments were
positive, i.e. more of the same. However, the
overriding subject for future activities relates to
being an advocate for geological collections and for
operating at a higher level where our voice can be
heard more clearly by those making higher decisions
about future funding. One area not picked up on by
the survey that we consider to be important is
encouraging outreach. Events such as Lyme Regis
Fossil Festival, Scarborough Fossil Festival and GA
Festival of Geology are important venues for
engaging with younger geological collectors and the
curators of the future.

Future
· Ensure that the any 'louder voice' is a positive one!
· Advocate geological collections by taking an active
role in national initiatives advocating Natural History
Collections (e.g. UK Consortium of Natural History
Museums).
· Develop links with MPs by inviting them to
Parliamentary Science Group meetings or launches
such as for the Geodiversity Charter for England.
· Conduct a combined approach to lobbying (with
NatSCA and SPNHC?) so that a cohesive message is
sent about the value of collections and the need to get
them used and funded.
· Lobby major bodies such as Arts Council, and the
MA and seek funds from bodies HLF or ACE to
support GCG activities.
· Encourage museums to host collections tours to
open up behind the scenes collections.
· Set up a prize for young geological curators to
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Skills
Request
no.
1

TABLE 1
Skill requested title
Early Career training/ Non-geological specialist resources

1.01

·

I have just been made responsible for a geology collection; I know very little about geology. What do I do?

1.02

·

Geological curator intern program

1.03

·

Mentors for early career palaeontologists/geologists interested in curation

1.04

·

How to run a curatorial traineeship in geology

1.05

·

Introduction into curating geological collections,

1.06

·

How to become more involved in collections,

1.07

·

How to become a geological curator

1.08

·

Latin for non-classically trained Natural Scientists

1.09

· Crash course on mineral identification for non-mineralogists

1.1

·

How to catalogue geology collections properly.

1.11

·

Basic curation (especially for curators without a geology background).

1.12

·

Information on how to answer enquiries with little knowledge.

1.13

·

Internships, helping early stage curators with training/mentorship, collections tours

2

Mid-Career/ Advanced Geological curation training

2.01

·

Managing volunteers in geology

2.02

·

Managing geological collections for Natural Sciences curators.

2.03

·

Moving geology stores.

2.04

·

Case studies from museums with geology collections that are involved in a store move project

2.05

·

Dealing with big and heavy objects

2.06

·

Dealing with thin sections/caring for thin section collections

2.07

·

Mineralogy and Igneous Petrology collections management

2.08

·

Insurance valuation of geological specimens

2.09

·

Social history for geology curators – HOGG?

2.1

·

Training in devising storage systems, particularly for rock collections.

2.11

·

Fieldwork training and active field collecting programs - curators may have little idea of how to log sections

2.12

·

Geological site excavation

2.13

·

Transport/couriering collections

2.14

·

Collections tours program

2.15

·

Keeping members informed of developments in museums beyond the area of collections management

2.16

·

"how to" on geological specimen labelling

·

Case studies from museums with geology collections that are involved in documenting
undocumented collections projects.

·

Doing geological collections reviews

2.17
2.18

3

Legal and Ethical

3.01

·

Legal ownership of fossils found on private land or Crown Property

3.02

·

Legality of geological specimens collected abroad

·

The law as regards to institutions acquiring and/or paying for fossils especially with regard to
the due diligence required to establishing true ownership.

3.04

·

Ethics and the law as it applies to geological collections

3.05

·

Fossil collecting and the law in Scotland

3.06

·

Dealing with current problems with disposal for financial reasons

3.03
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4

General Collections issues

4.01

·

Collection Management issues

4.02

·

Centralised database for collections and collector profiles

4.03

·

Standard info page of where to find information on jobs - regularly updated online.

5

Museum partnerships

5.01

·

How to get better use of collections by taxonomists, biographers, historians

5.02

·

Engaging with academia using geological collections for research, traditional and new areas

5.03

·

Links with research establishments and schools

5.04

·

Working with local geology/natural history groups

5.05

·

RIGS sites Conservation Research (collections and related museum research) Geoarchaeology

5.06

·

How to link up with RIGS groups.

5.07

·

Applying for grants to support networking.

5.08

·

Supporting amateur and professional individuals who care for their own private collections.

·

Creating dialogue between museums and professional/amateur fossil collectors who currently
possess fossils wanted by museums.

5.1

·

Setting up regional links

5.11

·

“How to engage with” and information related to other small scale community organisations with collections

·

Engaging with Natural England (and other organisations), National Trust, English Heritage
(and other organisations) the Geological Society of London/GA

5.09

5.12

6

Conservation/preparation/sourcing of curatorial supplies

6.01

·

Palaeontological preparation

6.02

·

Packaging of objects

6.03

·

Recommendations for suppliers of geological curatorial supplies

6.04

·

Standard info page of where to find information on care of collections - regularly updated

6.05

·

long term environmental control

6.06

·

"how to" on collections storage

6.07

·

Conservation techniques

6.08

·

Curatorial Products

6.09

·

Care of particular collections or on particular subjects

6.1

·

Dealing with emergency situations with geological collections

7

Digital collections creation/use/best practice

7.01

·

Cataloguing and relational databases

7.02

·

Connecting specimens and publications

7.03

·

Online databases

7.04

·

Database Development

7.05

·

Crowd sourcing for Geological Collections projects,

7.06

·

mass digitisation.

7.07

·

Microfossils Social Media Archives

7.08

·

Photography of fossils for digitised media

7.09

·

Digitisation of collections

7.10

·

Social media/online access: new ways of interpretation and learning - informal/formal

7.11

·

Digital media funding

7.12

·

Standardisation of collections databases and dictionaries

7.13

·

Web access to collections/Collections on -line

7.14

·

Blogs/twitter
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8

Advocacy

8.01

·

8.02

·

How to raise awareness and use of geological collections within regional museums.

·

Show the relevance of collections, not just about science but their relevance to the general community
and its relevance to social history
Training for senior museum managers to understand why NS collections are important and need to
be looked after.
Geological collections in peril - highlighting institutions to raise awareness what we are losing in
terms of expertise and collections in different regions.

8.03
8.04
8.05

·
·

‘How to’ improve advocacy for natural science collections and curatorial posts.

8.06

·

New finds and rediscovered collections.

8.07

·

Positive stories about how geological collections are being used.

8.08

·

Operating a “higher levels” collections advocacy campaign

8.09

·

contacting MPs/MEPS direct/lobbying

8.1

·

Lobbying ACE, DCMS, etc.

9

Outreach/exhibition/community engagement

9.01

·

geology and the new school curriculum

9.02

·

"How to" on geological exhibitions

9.03

·

Exhibition Planning

9.04

·

Developing new displays with geology collections

9.05

·

Case studies from museums with geology collections that are involved in re-display projects

9.06

·

How to do geological educational programmes

9.07

·

Making links with schools, colleges and other community groups.

9.08

·

Engaging young people with geology.

9.09

·

Exhibition design

9.1

·

Engaging with scientific debate, e.g. climate change

9.11

·

Social media online access new ways of interpretation learning - informal/formal

9.12

·

Museum events (planning of and delivery),

9.13

·

Geological outreach in the community.

9.14

·

How to do a ‘show and tell’.

10

Fund raising

10.01

·

Sourcing funds.

10.02

·

Applying for grants to support networking.

10.03

·

Securing external funding

10.04

·

Standard info page of where to find information on grants - regularly updated online

10.05

·

Digital media funding

10.06

·

Winning grants by crowdsourcing
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A WORKFLOW FOR DIGITAL PHOTOGRAPHY
OF FOSSIL SPECIMENS
by Paul A. Selden
Selden, P. A. 2014. A workflow for digital photography of fossil specimens. The
Geological Curator 10 (2): 93-97.
A workflow for digital photography of fossil specimens is presented, in the hope that
it will provide helpful for those wishing to set up a facility or enhance their existing
setup for illustrations of geological specimens.
Paul A. Selden, Department of Geology, University of Kansas, Lawrence, Kansas
66045, USA, and The Natural History Museum, Cromwell Road, London SW7 5BD,
UK. Received 20th October 2014. Accepted 9th December 2014.

Introduction

Setup

Since the resolution of digital photography has
increased over the years, a gradual change has been
made from traditional, film photography to digital.
Now that full-frame (35 mm) sensors with 24
megapixels and more have become both widely
available and at reasonable cost, I have developed a
workflow for getting the finest resolution out of
fossil specimens, which now surpasses that
obtainable by film photography. An additional
impetus for this change has been the difficulty or
inability to borrow specimens from some museums
(e.g. in China), so that having a high-quality
representation of the specimen in digital form is
almost as good as having the specimen under the
microscope, and frequently more convenient.

There are two setups: the microscope (Figure 1) and
a macrophotography setup on a copy stand. The
protocol for the microscope is given here, together
with notes on the macro setup and workflow, as
appropriate.
In Figure 1, the labels refer to the items below:
A.
Eyepiece cover; remember this to keep light
from entering through the eyepiece.
B.
Canon EOS 5D MkIII. This is a full-frame
sensor DSLR. The MkII is also fine, as is any similar
DSLR, but make sure that the camera allows for
LiveView (the mirror flips up so that the image can
be seen on the computer screen).

The protocol described here was presented at an
iDigBio workshop in Michigan in 2013
(https://www.idigbio.org/wiki/index.php/Fluid_Pres
erved_Invertebrate_Imaging), and has been
requested by numerous people. Here, I describe the
workflow in the hope that some readers might find it
useful. Of course, everybody has their own needs,
budgets, and existing facilities, but it is hoped that
there will be some useful ideas here. The protocol
has served very well with the study of fossil
arthropods of various kinds and preservational types.
Moreover, one photograph produced using this
workflow was honoured as one (out of 14) of
Nature's Images of the Year 2010 (Van Noorden
2010).

C.
M42 screw adapter. Use the correct
mounting adapter to enable fitting your camera body
(in this case Canon) to the M42 screw thread on the
phototube. Adapters are cheap from any
photographic store.
D.
Phototube. The Leica uses a series of tubes
and includes a 10× eyepiece. The whole assembly
fits onto a trinocular head. This assembly will also
mount on a lateral photo tube.
E.
I use Leica stereoscopes. Any microcope
will do: when travelling, I carry the camera and
phototube assembly (A-D), which will mount on
any of the Leica M and DM series microscopes. The
one shown is an M16; we also have M205C and
DM2500M microscopes in the laboratory; the photo
assembly can be transferred between them all. Make
sure the iris diaphragm is wide open, any drawing
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Figure 1. The macrophotography setup. See text for explanation.

tube is turned off, and (IMPORTANT) also cover the
eyepieces and/or turn off the room lighting,
otherwise you will get an image of any ceiling
lighting superimposed on the photo. It took me years
to discover this problem! Also, if using polarization,
you do not want stray, non-polarized light entering
the system.

both alcohol immersion and polarization gives the
best results. For a quick snap, it is possible to just
squirt ethanol over the specimen, but for longer
sessions, and to reduce glare from things breaking
the surface, full immersion is better.

F.
Lighting: I use a variety of lighting setups:
twin swan-neck (shown), and ring-illumination most
commonly. For polarization on the stereoscope, I
have a circular band of polarizing filter (cut by hand
from a sheet) taped over the ringlight, and a
photographic circular polarizing filter fits neatly
between the ringlight and the objective lens. Rotating
the polarizing filter to extinction provides higher
definition and also cuts out any glare if immersion
the specimen in alcohol. Both filters are available
from photographic stores.

I.
I use an Apple MacBook Pro laptop for
capture and processing (more on that later). This
machine has the maximum amount of RAM (16GB)
and SSD drives, to manage large files in Photoshop.

H.

USB cable from camera to computer.

J.
Software: any image capture software will
do for capture, including that supplied by Canon
(shown in the picture). However, I prefer DSLR
Assistant, which is dedicated Canon-Mac capture
software. It is simple to use and does a few neat
things. For example, if using it on a
macrophotography setup, a stack of images can be
taken automatically as the software will drive the
macro lens remotely. It cannot, of course, do this on
the microscope.

G.
The specimen shown here is dry but,
normally, immersion in alcohol increases the
definition of the fossil from the rock. Sometimes,
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Workflow

cameras, but also available for Canon and Nikon
DSLR. It is expensive, but if your educational
institution has a contract with a software supplier,
you can get it more cheaply. I batch convert all to 8bit RGB TIF files (with this setup, they are each
about 60MB in size). Store the RAW files
somewhere safe!

1.
Turn on the lighting, connect the cable from
the camera to the laptop, and turn on the camera. This
usually starts up the software automatically; if not,
open the application and choose LiveView: a picture
of what you have under the microscope will appear
on the screen.

10.
Now begins the process of stitching
everything together in Photoshop. First, find the
stacks. Photoshop has a number of ways to stack and
merge. Under File > Automate, you will find
Photomerge. This only works for a few files, e.g. a
short panorama, or 5 or 6 well-overlapped pictures of
a specimen that would not fit under the microscope
completely.

2.
Camera is set to P; use a low ASA (100) for
lowest noise (less of a problem these days), and the
software works out the exposure. However, if there is
any vibration, use higher ASA (400, perhaps). Photos
are taken in Camera Raw. This allows for archiving
at the best quality and widest color gamut.
Occasionally, I do need to go back to these raw files.
3.
Name your files and folders! Choose any
system you want; I use the date and specimen
number (also part or counterpart, if relevant).

11.
For stacking, it is usually safe to use File >
Scripts > Load Files into Stack… Use the option Add
Open Files to load your stack (if more files open, you
can remove the unwanted ones), or else browse for
the files you need. Make sure you click on the
Attempt to Automatically Align Source Images
option; this will align the images ready for merging.
If this works (check the thumbnails), go to 13.

4.
Zoom in or out for the crop you want and
focus the microscope. I normally take a preliminary
shot of the whole specimen together with a mm scale
alongside, for future reference (see later).
5.
For most fossil spiders, I take a large mosaic
of high-magnification shots which are then stitched
together. So, starting at one corner (e.g. top left), take
a shot. NOTE: you will need some shots of bare rock,
e.g. between outstretched appendages and around the
edges, in order to end up with a nice, rectangular
final picture for publication.

12.
The fully manual method of stacking is to
copy and paste all of the images you want to stack
into one file (each one on its own layer). If one layer
is a Background, it must be converted to a numbered
layer by double-clicking on it in the Layers palette
and renaming it (e.g. Layer 0). Then, select all layers
in the Layers palette, and choose Edit > Auto-Align
Layers… there are various options here; I just leave
it at Auto and do not check the other boxes. This
command will attempt to align the layers, just as in
the automated method in 11.

6.
For each shot, if not all is in focus, take
several shots of the same area at different focus
planes. Focus manually on the microscope or, if
using a macro lens, this can be achieved
automatically with the software. Later, these can be
stacked.

13.
Once the layers are aligned, they can be
merged. Again, all layers you want to merge must be
selected in the Layers palette (they will be already
after the last step). Choose Edit > Auto-Blend
Layers… The options here are: Panorama or Stack
Images (choose stack for this step) and make sure
you check Seamless Tones and Colors.

7.
Move the specimen gently to the next shot
area, remembering that about a 40% overlap is
necessary for stitching successfully. If necessary,
take a stack again.
8.
After all shots are taken, turn off LiveView,
turn off the camera, and close the software.

14.
The result will be a series of layers in the
Layers palette showing which parts of each layer
have been used or deleted. It is worth looking
through these to identify if any images are redundant.
If all looks OK (the main window shows the result),
then choose Layers > Merge Layers to merge them.
You will probably see that the edges are a bit blurry;
IMPORTANT: crop the image to exclude these
artefacts.

9.
Find your folder, in which will be all the
shots taken. I now convert these from RAW to TIF.
Photoshop can do this, but I use Capture One Pro,
which is reckoned to be the best. It is a professional
photography suite, similar to Aperture or Lightroom,
written for the Phase One medium format digital
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Figure 2. Photoshop screen shots showing the result of merging three shots of a specimen into a panorama. A
before merge; B after merge.
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Figure 3. Photograph of a fossil plectreurid spider from the Jurassic of China, showing how the final composite
picture with high resolution can be zoomed in to examine details. A whole specimen; B zooming in to the top left,
showing male palp embolus and clasper on leg I; C zooming again, showing tip of embolus (right) and clasper on
leg I (left); D composite picture merging part and counterpart indicates that clasper is composite of fused
macrosetae (left) and tip of embolus (right, arrowed) is revealed to have a fine, helical flagellum (from Selden &
Huang 2010).

15.
Having done all the z-stacks in this way
(NOTE: this can also be done in Helicon Focus or
other stacking software), we now need to stitch the
images together into a mosaic. File > Automate >
Photomerge is unlikely to work on more than a few
images (see above), in which case, do it manually.
Copy and paste the first image onto the second and
auto-align (see 12, above). Then select all layers
(remember: none can be a Background) and choose
Edit > Auto-Blend Layers… as in 13. This time,
select Panorama, and make sure you check Seamless
Tones and Colors. The result will be a small
panorama of the two images.

17.
Gradually, the whole specimen can be
assembled into one large mosaic. Each image starts
at about 60MB, so the final image can reach 1 or
2GB in size. You will need plenty of RAM and
scratch disk space to manipulate this file.
18.
The final image may show distortion around
the edges. To remove this, I drop in the picture I took
of the whole specimen with the scale ruler. Make this
layer half-transparent (Opacity 50% on the Layers
palette), so both layers can be seen. Resize and rotate
the new layer with the whole specimen until it is at
the size of the underlying panorama. If any distortion
needs correcting, the panorama layer can be distorted
back to its correct proportions by selecting the layer
(Select All) and then carefully using Edit >
Transform > Warp to get it into shape. In practice, I

16.
Continue to add each image to the new
panorama, merging, and saving after each step. See
Figure 2.
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zoomed in to reveal the finest detail, nearly as good
as having the original specimen under the
microscope. Crops can then be used as illustrations
of details (Figure 3B,C). Moreover, part and
counterpart can be superimposed (with one reversed)
and aligned to provide a view of the complete
specimen. In the example given here, this allowed
the discovery of a fine, helical tip to the male spider's
palpal embolus (Figure 3D).

find that there is really little or no distortion and this
step is unnecessary, but it is worth checking.
19.
Before removing the additional layer, create
a new layer and draw a black line along 1mm (or
whatever) of the ruler to provide a scale for the main
panorama. Now, the imported layer can be deleted,
and what remains is a panorama with a scale on a
separate layer.
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20.
Now, the image can be cropped to remove
the ragged edges. If there are still some patches
without an image (e.g. at the edge where some
background is missing), then use of the Clone Stamp,
Spot Healing Brushes, etc. can be used to fill in.
Adjustments to colour, tone, contrast, saturation, etc.
can now be applied; also some sharpening if
necessary.
21.

I thank Gil Nelson (Florida State University) for
encouragement.
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A final result is shown in Figure 3.

Conclusion
The final, large file can be reduced in size to produce
a whole-specimen illustration (Figure 3A), or
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ROCKBAND - USING PARTNERSHIP WORKING
TO PROVIDE ACCESS TO GEOLOGY COLLECTIONS
by Christine Taylor
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Many museums have geology collections which lie unused through lack of specialist
staff and expertise. A partnership of five museums in south east England was
formed to try and address this problem by commissioning a suite of geological
activities that could be delivered by staff and volunteers with little geological
knowledge. This local initiative was very successful, with targets for improved
access to local geology collections being exceeded by over five times in the first
year. The project model is one which could be applied more widely.
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Introduction

Aims of the Project

Geology can be a challenging subject to interpret
without specialist staff. Museum staff can inherit
good quality displays, but delivering geology
sessions based on the subject can be daunting. To try
and address this problem a partnership was formed
with the aims of pooling ideas and expertise to create
a suite of geological based activities that could be
delivered by non specialists.

· To produce a series of mobile learning kits
exploring the geological heritage of the south east
region. These to include story telling
resources/props, focussing on stories, poems, songs
and folklore aimed at younger children, to provide a
fun introduction to geology.
· To recruit and train 10 volunteers (2 per partner)
in how to deliver relevant educational sessions using
the new materials.
· To engage 450 participants through the education
sessions, including primary school groups, adults,
blind and partially sighted people.

The partnership, known as Rockband, has its origins
in SLIME (Science Links in Museum Education), a
network of museums in the south east region.
Although a number of museums were initially
interested in the project, several dropped out, through
other commitments, before the preliminary bid stage,
leaving Hampshire County Council Arts and
Museums Service (now called Hampshire Cultural
Trust), English Heritage Education Centre, Dover
(specifically providing for the Osborne House site on
the Isle of Wight); Canterbury City Museums and
Galleries Service, Kent; Painshill Park, Surrey; Vale
and Downland Museum, Oxfordshire as the five
partners. In retrospect the smaller partnership made
the project much more manageable and ensured that
the resulting suite of activities was of very high
quality.

The Rockband Kit
After identifying a wish-list of resources and
outcomes, the partners successfully secured a grant
of £47,250 from the Heritage Lottery Fund (Your
Heritage Programme). The funding was used to
commission a team of freelance consultants to help
interpret the geology collections within the
partnership in innovative and exciting ways.
The resulting kit comprised the following:
· A bespoke 'collector's box' of geological
curiosities. These can be uses in facilitated sessions
with schools as well as self led family and group
activities (Figure 1).
· A Geology/Chemistry Kit with resources and a
session plan relating to building materials.
· A series of cards entitled 'Think you've found a
Fossil?' These illustrate some of the most commonly
found fossil invertebrates in South East England,
along with fascinating facts about them.

Four of the five partners have geology collections,
two with substantial collections. The diverse
backgrounds of the individual members helped form
the basis of the HLF bid and ensured that overall
aims of the project had an even balance of geological
/ curatorial / educational requirements.
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· A bespoke textile geological mat, one for each
partner. Each mat, produced by textile artist Jenny
Langley, contains pockets for fossils, flaps to
explore, geological features and a story, with props,
relating to the local area of each partner (Figures 25)

Figure 4. An outdoor session with a children’s group
and a large textile mat.

Figure 1. Children’s Festival activity using a bespoke
‘collector’s box’.

Figure 5. Bespoke textile mat of Vale and Downland
geology.

Benefits from working in a
partnership
Figure 2. Adult group working with a bespoke textile
geological mat.

Figure 3. Bespoke geology mat as a geological map,
with the Isle of Wight in bottom centre of view and
Danebury Iron Age Hillfort top middle.

1.
Value for Money
The partnership made this an extremely cost
effective project. The different backgrounds of the
individuals on the team enabled the partnership to tap
into geological, art based, story telling and
educational expertise. It also enabled the exchange
of non data material between the partners especially
where gaps in the collections were identified.
Although the collectors' boxes, story telling props
and interactive mats were bespoke to each partner
there were elements that were generic, such as the
bases and some of contents of the collectors' boxes.
The 'Think you've found a Fossil Card' and geo /
chemical kits were generic as they used examples of
fossils and rocks common to all partners.
2.
Network of expertise
Working with partners provided a ready made
network of expertise and experience which has been
sustained long after the completion of the project.
Each partner was able to contribute different skills
and provide advice, enabling a collective and
individual growing in confidence.

100

3.
Improved access to geology collections
The initial target of 450 participants to be engaged
through education sessions, including primary school
groups up to adults, blind and partially sighted
people was exceeded by over five times (2632)
within the first year. Of these 96 were partially
sighted, many of whom had never held a fossil
before.
The Rockband Kits fit in perfectly with recent
changes in the National Curriculum - Rocks (Year 3),
All living things (Year 4), Evolution and Inheritance
(Year 4) and has providing 'off the peg' geology
sessions for schools.

The geographical distance between the partners
meant that meeting up on a regular basis became
costly in both time and money. Communicating by
email, telephone and setting up a closed group on
Facebook proved to be effective methods of
resolving this issue.
Factoring in enough time for consultants is critical,
especially if commissioning bespoke products. If
partners are in close proximity a visit to two partners
in a day is realistic. In this instance only one site
could be visited in a day.

Conclusion

In order to meet the demands of the brief partners
had to seek out local geological expertise, which in
itself has opened out new opportunities to work with
local universities, geological societies and other
geological initiatives. The project also provided staff
with research time to get to know their collections.
One of the targets of the project was to engage 10
volunteers. By March 2014, 34 people had
volunteered and been trained in the delivery of
geological sessions. Twelve of these were new
volunteers, many with a geological or science
background.

Partnership working is an extremely effective
method of working, especially in an area where more
expertise or research into a subject area is required.
The success of a good partnership relies on the
members working closely with each other as a team.
Costs can be kept down, especially where there is a
generic aspect to the project and resources can be
shared or duplicated. Finally, share the success of the
partnership - this one has gained impetus since its
completion and ensured that the geology collections
are firmly embedded in the activity planning process.

Volunteers continue to be recruited, not just to
deliver Rockband sessions, but to work on the
geology collections. Making initial contact with
other institutions and talking to geologists led to
offers of volunteer work and student based projects.

Taylor, C. 2013. Rockband links fossils, fabrics and
folklore. Earth Heritage 40, 24-25.

Lessons learned from working in a
partnership
A partnership can only work effectively when each
partner pulls their own weight! Although frustrating
when potential partners did not respond to requests
for basic information, the initial planning stages
identified potential issues and ensured that partners
were fully signed up to the project. Even when a key
member of staff at a partner museum left just before
the delivery of Rockband activities, the remaining
members were able to exceed the targets set out in
the HLF bid.
Don't under estimate the amount of training required.
The bespoke nature of some of the activities (mat and
the collector's box) and the diverse backgrounds of
the partners meant that the one training day wasn't
enough time to become fully engaged with the
product. Further training at partner sites was required
to deliver the sessions confidently.
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GENERAL MEMORANDUM OF UNDERSTANDING
BETWEEN
THE NATURAL SCIENCES COLLECTIONS ASSOCIATION,
THE GEOLOGICAL CURATORS' GROUP
AND
THE SOCIETY FOR THE PRESERVATION OF NATURAL HISTORY COLLECTIONS
The Natural Science Collections Association (hereafter referred to as NatSCA), The Geological Curators'
Group (hereafter referred to as GCG) and the Society for the Preservation of Natural History Collections
(hereafter referred to as SPNHC) have reached an agreement on the following points in order to increase and
improve collaboration in areas of common interest.
WHEREAS
o The aims and missions of NatSCA, GCG and of SPNHC (hereafter referred to as The Parties)
are both complementary and overlapping.
o The Parties wish to recognize and benefit from the professional contribution made to their
shared goals by the members and representatives of each Party.
NOW IT IS HEREBY AGREED THAT THE PARTIES SHALL
1. Establish on their respective Committees (NatSCA and GCG) and Council (SPNHC) an ex-officio
member position for the President (or appointed representative) of the other Party.
This non-voting member will make all reasonable efforts to attend meetings and conference
calls as would any voting member of the Board or Council, receive correspondence and
serve as liaison between their organization and the other Parties.
2. Collaborate to establish a separate Memorandum of Understanding (MoU) to provide
guidance and directions for productive collaborative/joint NatSCA-GCG-SPNHC
Conferences.
3. Actively seek opportunities to cooperate and, when considered appropriate by all Parties, initiate
and implement joint action, including- but not limited to- issuing joint statements regarding
issues of concern in areas of common interest and value.
4. Draw on mutual synergies and complementarities, through the exchange of information and
the implementation of strategies, projects and activities jointly elaborated and undertaken
pursuant to this MoU, with progress being reviewed through regular contacts between the
Presidents (or appointed representatives) of the Parties.

Limitations
The Parties will seek the approval of their respective governing bodies, as appropriate and as
mandated by their respective Bylaws, in implementing the cooperation foreseen under the present
MoU.
Fulfillment of the Parties' obligations under the present MoU shall at all times be subject to the terms
of their respective Bylaws and the extent of the financial resources available to each Party.
Collaborative projects arising from the current MoU will be governed by separate detailed agreements
between the Pat1ies. Such agreements will include - but will not be limited to- financial arrangements
associated with the collaborative projects.
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Nothing in this agreement shall be construed as creating an exclusive relationship between the Parties.
Each Party shall be free to enter into other agreements with other organizations.
Each Party's obligations under the present MoU shall be subject to: a) the application of its respective
rules and policies and b) the availability of the appropriate financial resources.
Neither party shall use the name and /or logo of the other Party without prior written permission.
Under no circumstances should any Party use the name and/or logo of any other Party in a way that
implies that they are part of the other Party or under its patronage or affiliation.
The present MoU may be amended, at any time, upon formal written request by one Party and written
agreement of the other Parties.

Duration and Termination
The present MoU shall take effect upon its signature by the Parties and shall extend through
alternating representatives. It can be extended or amended.
Any Party may terminate the present MoU by giving 60 days written notice to the other Parties or by
mutual consent of all Parties.
Any dispute arising out of the interpretation or implementation of the MoU will be settled through
discussion between the Parties.
This Memorandum of Understanding signifies a statement of intent to collaborate, but it is not a legally
binding document.
IN WITNESS THEREOF, the duly authorized representatives of the Parties affix their signatures
below on the two original copies in English.
Signed on the 26th of June 2014
Clare Brown
Chair of NatSCA
Chris Norris
President of SPNHC
Dr C. Giles Miller
Chairman of GCG
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